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Frestimate Users Manual Version 3.80 
 

1.0 Essentials 
 
Prior to using FREstimate, it is essential that you have an understanding of the purpose 
and steps for doing a software reliability prediction!  The "Big Picture" illustrates the 
major steps involved in doing a prediction. It is also strongly recommended that you 
understand the terms used in the prediction process.  SoftRel provides training in these 
two areas (see www.softrel.com).  This training is strongly recommended for users who 
have never preformed a software reliability prediction. 
 

1.1 Software Reliability Big Picture 
 
There are two types of software reliability measurements.  
 
Prediction models- regardless of whether they are for software reliability or any other application 
- are developed by collecting trained data and observing relationships in that features and some 
outcome.  In the case of software reliability the outcome is delivered defects normalized by code 
size.  The features vary from model to model and are generally related to development practices.  
Some models have only one feature.  Some models have many features. The model is the 
mathematical expression that determines some outcome given some set of features.   
 
Predictors are used early in the development lifecycle to: 
• Determine whether the current capabilities/development practices are suitable for meeting a 

system reliability objective 
• Select the development practices that would allow the system reliability objective to be met 
• Determine whether vendor supplied software will meet a system objective 
• Determine suitable quality and reliability objectives for the software 
• Determine staffing requirements for maintenance and testing 
• Predict the inherent number of defects in the software at the start and end of testing 
 
Estimation models - are models that project the future based on what has happened in the 
immediate past - on this project.  Estimators do not use trained data like predictors; they use data 
collecting only from the project in which we are interested in measuring.  Estimators have a 
variety of purposes including: 
 
• Projecting how many more hours of testing are needed to reach some reliability objective 
• Projecting how many more defects must be detected and then fixed to reach some reliability 

objective. 
• Validating a reliability prediction 
 

http://www.softrel.com
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1.2 The Prediction Big Picture. 
 
If you select Help->Get prediction started you will see the Big Picture literally speaking.   

 
Figure 1- The Big Picture 

 
There are three general objectives: 

 Improve 
 Staff 
 Quantify 

There are 4 steps to executing each of these objectives: 
 Data collection (orange nodes) 
 Prediction (blue nodes) 
 Management/planning (green nodes) 

 
The wizards as well as the HTML file which is launched from the main dialog are designed to 
walk you through each of these components and help you get your project set up. 
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Table 1 - Tasks required 

Goal Tasks required 
Improvement goals   
Reduce defects that are visible to your customer(s) 
by a specific predefined percentage 

Predict deployed defects 

Assist a vendor to reduce defects that are delivered 
to you from a vendor 

Predict deployed defects 

Staffing goals   
Predict defects that will be found by customer so as 
to plan for warranty and maintenance 

Predict staffing profile 

Predict defects that will be found during testing so as 
to plan resources required to find those defects  

 

Quantify goals 
  

Identify the system reliability for hardware and 
software (usually to provide to one or more of your 
customers) 

1A, 1B, 1C, 2A, 2C, 3C2  

Establish vendor selection or delivery criteria for 
vendors supplying only software 

Defect driven - 1A, 3A, 4C OR 
Reliability driven -1A, 1B, 1C, 2C, 3C1, 4C 
Performed on each vendor version one at a time 

Establish vendor selection or delivery criteria for 
vendors supplying hardware and software 

1A, 1B, 1C, 2A, 2C, 3C2, 4C performed on each 
vendor system one vendor/system at a time 
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1.4 Terms and Definitions 
 
Defect density – Defects per unit of size.  
 
The number of defects can be determined by multiplying the defect density by the predicted size 
either EKSLOC or effective function points.  If the effective KSLOC or effective function points is 
blank, then the KSLOC or function points is used. . The unit of measure (whether KSLOC or 
function points). 
 
Defect density confidence – The confidence on the defect density prediction is determined by 
the model used to predict defect density.  Some models, such as the SEI CMMi or industry 
models have a lot of variation so the confidence bounds are higher than with the Shortcut or Full-
scale models.  The confidence is used to establish the upper and lower bounds on the defect 
predictions. 
 
Failure rate – Failure rate is computed using a general exponential model.  It is a function of 
defects predicted, duty cycle and growth period. 
 
The end of test failure is measured at delivery time.   
 
λdel = End of Test Failure rate = Ndel (1- exp(-Q del)) / T 
 
The operational failure rate is measured at the end of the defined growth period.  If you have 
input 0 for growth period then these two predictions will have the same value. 
 
T = Number of hours operating per month or the duration in hours of that time interval.  If the time 
interval is a month and there is one system running the software full time then T = 730 hours for 
example.  
 
TF = Growth period 
 
Ndel = number of inherent defects delivered.  This is determined by using any prediction technique 
and multiplying by the KSLOC or function points (depending on what you set the unit of measure 
to). 
 
N0 = how many defects are predicted to be found during testing. 
 
λ0 = initial failure rate prediction - failure rate at the start of testing.  The start of testing is when 
the failure rate is at its largest.   
 
MTTFi = T / (N del ((exp (-Q/TF)*(i-1))-exp(-Q/TF)*i)) 
 
i = month after delivery for which MTTF is being solved for 
 
MTBI = Mean Time Between Interruptions  
 
Interruptions – Some defects can be resolved without a change to the source code.  For 
example, defects that have a viable workaround.  These are called interruptions.  
 
N del = number of inherent defects delivered.  This is determined by using any prediction 
technique and multiplying by the KSLOC. 
 
Operational Failure rate i = failure rate after i months of growth after delivery =  
N del ((exp (-Q del /TF)*(i-1))-exp(-Q del /TF)*i) / T 
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MTTF i – Since an exponential model is used to calculate failure rate, the Mean Time To Failure 
is = 1/ failure rate.  MTTF is predicted based on all defects predicted to require a corrective 
action. 
 
MTBI i = MTTFi * Ratio of interruptions to defects that require a corrective action 
 
MTTCF or Critical MTTF - MTTF computed using only those defects that impact availability and 
have no workaround. 
 
Percentage of defects that are critical – This field is used to filter for outputs for only defects 
that will impact mission availability.  If you ignore this field then no filtering is done. 
 
Critical defect density – If you enter a value for percentage of defects that are critical, this value 
will be multiplied by the defect density for only the critical  
 
KSLOC and the result is a defect density for only serious defects. 
The number of serious defects can be determined by multiplying the severe defect density by the 
critical EKSLOC or critical function points.  If the critical  
 
EKSLOC or critical function points is left blank then the EKSLOC or effective function points is 
used.  If those are blank then the KSLOC or function points is used.  The unit of measure 
(whether KSLOC or function points) is determined by the General Inputs dialog. 
 
Critical failure rate – If you entered a value for percentage of defects that are severe, a serious 
failure rate is computed using the serious defect density. 
 
The end of test severe failure is measured at delivery time.  The operational severe failure rate is 
measured at the end of the defined growth period.  If you have input 0 for growth period then 
these two predictions will have the same value. 
 
Critical MTTF – This is equal to 1/ severe failure rate since an exponential model is used to 
compute failure rate. The severe end of MTTF is measured at delivery time.  The severe 
operational MTTF is measured at the end of the defined growth period.  If you have input 0 for 
growth period then these two predictions will have the same value. 
 
Critical MTBI – Critical MTTF * Ratio of interruptions to defects 
 
Duty cycle – This is the percentage of time that the entire software system is operational per 
month. 
 
Component utilization – Some components within a software system may be utilized more then 
others.  Some components may be COTS (commercial off the shelf software) and may have 
different defect densities then other components.  Some components may be reused and 
therefore also have a different defect density then others.  If you have this data available, you can 
override the size inputs in the interim section of the All General Inputs page and input size and 
utilization estimates for each component of the software system.  This method allows you to 
select different models for different components in your system as opposed to using one model 
for all components.  
 
Growth period – This is the expected number of months after delivery in which the software will 
be repaired and therefore the reliability will grow.  You can also think of this as how long it will 
take for the very last defect caused by this version to be found.  Usually this is 2-3 major release 
cycles and is usually 36-48 months. 
 
Next release  - The time to the next release is the number of months until a major release (new 
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features).  This is used to extrapolate the failure rate, MTTF, reliability and availability until the 
point in which the current version is replaced with a new version.  The predictions at this 
milestone represent the best that the software will exhibit as long as new features continue to be 
added to it.  The failure rate, MTTF, reliability and availability predictions at the end of growth 
milestone represent the best that the software will exhibit assuming that no new features are 
added.   
 
Average during release – The failure rate, MTTF, reliability and availability predictions are 
computed as an average during the first release cycle.  This is because this is the most useful 
metric for a user of your software.  The predictions at the end of the release represent only a best 
case while the predictions of the average during the release are a more useful indicator. 
 
KSLOC – The unit of measure for size is either KSLOC (1000 lines of source code) or function 
points.  If you select KSLOC, then KSLOC from the general inputs page is used to compute 
defect density.  If you select function points then function points from general inputs page is used.  
 
EKSLOC is the effective KSLOC.  Sometimes code is reused.  That reused code has 
theoretically already been debugged.  EKSLOC is KSLOC minus reused (tested!) KSLOC. 
 
Critical EKSLOC is the EKSLOC that is associated with functions that may/will cause a mission 
critical failure.  Not all KSLOC has the potential for causing a critical failure.  Sometimes there 
may be auxiliary or optional functions that are useful but do not cause a system failure when are 
not available.  If there is code in your system that will never contribute to a critical failure, then 
remove that EKSLOC from the count and enter the result in this field. 
 
Function points - The unit of measure for size is either KSLOC (1000 lines of source code) or 
function points.  If you select KSLOC, then KSLOC from the All General Inputs page is used to 
compute defect density.  If you select function points then function points from the interim section 
of the All General Inputs page is used. 
 
Sometimes code is reused.  That reused code has theoretically already been debugged.  
Effective function points are function points minus reused (tested!) function points. 
 
Critical effective function points is the effective function points that is associated with functions 
that may/will cause a mission critical failure.  Not all function points have the potential for causing 
a critical failure.  Sometimes there may be auxiliary or optional functions that are useful but do not 
cause a system failure when are not available.  If there is code in your system that will never 
contribute to a critical failure, then remove that effective function points from the count and enter 
the result in this field. 
 
Executable size – This is the number of bytes in the executable.  This may be used for size if the 
neither function points nor KSLOC is known. 
Software components – a software component is a component of the software system, which has 
functional characteristics.  A software component may be a third party component.  The top of the 
software architecture is a CSCI (Computer Software Configuration Item).  This is either an 
executable or a DLL (Dynamic Link Library).  Components are the next layer of architecture.  
Several components may constitute a CSCI.  Several CSCI’s may constitute a system.  Within 
the CSC, there are usually several if not many CSU’s (Computer Software Units).  The Unit is the 
lowest level of architecture and is a function or procedure if a procedural language is used or a 
method if an object oriented language is used. 
 
Upper and lower bounds on size – Since size is a prediction, you should supply the upper and 
lower bounds on the size prediction as these are used to compute the confidence of the size 
prediction.  The relative error of the size prediction generally decreases with each phase of 
development until the code is completed and tested and at that time the size can be counted and 
is therefore known.  At the requirements review milestone (the point in which the requirements 
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are signed off) the size prediction may be off by 50% or more.  At the design review milestone 
25% or more.  During coding the size prediction may be within 10%.  Finally when testing is 
complete the size prediction is no longer a prediction.   
 
Growth rate or Conversion ratio – the growth rate or the conversion ratio converts defects to 
failure rate.  It is computed either by historical data from projects at your company or by using the 
Rome Labs lookup chart. 
 
Growth rate confidence – Since the growth rate is a prediction, we need to have a confidence 
value for it to establish the upper and lower bounds on the failure rate and MTTF predictions.  
When you select the industry type, the average confidence from our database of growth rates is 
also selected at the same time that the growth rate is selected. 
 
Expansion ratio – This is the density of your language compared to assembler.  FREstimate 
calculates all defect densities in terms of assembler.  This allows you to multiply the prediction 
based on the expansion ratio that is appropriate for the language.  You can override this value if 
you wish.  FREstimate uses default values for each language. 
 
Life cycle phase 
The phases of the lifecycle range from concept to delivery.  The life cycle phase is used to 
establish the default size prediction confidence bounds.  Rome Laboratory model uses this field 
as well.  Some of the factors in the Rome Laboratory model are phase specific. 
 
Application type 
The application type is used by the Industry model and the Rome Laboratory model.  It is also 
used by the wizards to help you pick the model that works the best for your application type.  
When you select the application type, the Industry model computes an average defect density for 
that application type.   
 
The application type is also used to select a default growth rate and the growth rate confidence 
bounds. 
 
When you select the application type, the Rome Laboratory model uses that application to 
determine the “A Factor” which is a baseline defect density.   
 
Language 
Language is an input because it is used to convert the predicted defects per KSLOC of assembler 
to whatever language is applicable for your project.  If you leave this as assembler and your 
language is C++ the predicted defects could be off by a measurable amount as Assembler is 
denser then C++.   The language field and the Code Expansion field are related.  When you 
change the language field, you change the default for the code expansion field.  You can override 
this default, however. 
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2.0 File Menu 
 
When you first launch Frestimate, there are no open project files.  You will see the below screen.  
 

 
 
The first thing that you need to do is open an existing project file or create a new project.  Select 
the File Menu. 
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The file menu contains the project file related functions.  You must have a project open to perform 
a software reliability prediction.  
 
• New - Creates a new project file and then opens that file 
• Open - Opens an existing project file 
• Recent files – Allows you to select from a list of the 4 most recent project files opened 
• Close - Closes the project file you are currently editing. 
• Save As - Allows you to save this project to another name and then opens that file. 
• Global Preferences- allows you to toggle the units of measure for time (i.e. hours, millions of 

hours or billions of hours). 
 
• Exit - Exits FREstimate. 
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2.1 New File 
 
The new file option allows you to create a new prediction file.  One file is created for both the 
prediction and estimation models.  You can create this file on any drive and in any folder. 
 

 
 
To create a project: 
 

1. Click on “File” from the main menu with your mouse and then click on “New”. The “New” 
function is not enabled when a project file is already open. 

2. Decide which drive and which folder you want your new project to reside on. 
3. Enter the name of the new file.  Do NOT include the extension “.mdb”. 
4. Click on “OK” to create the new project, or click on “CANCEL” to cancel the creation of 

the new project 
5. If that selected project name already exists you will not be able to create it. 
6. After the project is successfully created, you may open it and do all other “File” 

operations on it.   
 
Name your project accordingly so that everyone using the software will put the correct information 
in the correct project.  One good practice is to create a new project when going to a new release, 
keeping all of the closed features/corrective actions in one database and creating a new project 
with the features/corrective actions that are still active in a new database.  If you have software 
products at your organization that are not related in any way then you should also create 
separate projects for each product.  
 
Projects are database files that contain all of the information needed for predicting and estimating 
reliability. How you define projects is up to you. Generally a project is created for every release of 
a particular piece of software.  You may also want to create one project for just the severe defects 
that are detected during testing. 
 
Another good practice is to create a new database when there are allot of records in the current 
project.  The more records there are, the slower it will get to manipulate that database.  If you do 
create a new database for this reason, make sure that you group the features/corrective actions 
so that the older/obsolete ones are in one file and the newer records in another file. 
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2.2 Open File 
 
You may open only one file at a time.  You can select from any drive on your computer.  Only 
valid FREstimate files will be displayed.  If you open a file that is not valid, you will be notified 
appropriately.   
 
Opening a project will open the database file selected.  When a project is not open, only the New, 
Open and Exit commands are enabled.  Once a project is open then the other menu items will be 
appropriately enabled. 
 
Version 3.7 will upgrade FREstimate files created from version 3.6, 3.5, 3.4 and 3.3.  However, it 
will not upgrade FREstimate files that were created from versions earlier than 3.3.   
 
NOTE: The Full-scale and Shortcut models changed dramatically between version 3.6 and any 
earlier version of FREstimate.  Even if FREstimate upgrades your files to version 3.6, you do 
need complete the Full-scale and Short-cut surveys with version 3.6. 
 
To open a project: 
 
1. Click on “File” from the main menu with your mouse and then click on “Open”. 
. 
2. Select the file you would like to open using the scroll window or the up and down arrow keys. 
 
3. Click on “OK” to open the project, or click on “CANCEL” to cancel the open. 
 
4. Once a file is opened, you will be able to select from the Prediction, Estimation and Fielded 
MTTF metrics menus. 
 
The “File Open” function is disabled when a project file is already open.   
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2.3 Recent Files 
 
You can also open a file by using the Recent Files option.  When you select “Recent Files” from 
the “File” menu you will see the 4 most recent files that you have opened/created.  The first time 
that you use Frestimate you won’t see any file names in this list.  “Recent Files” is only enabled 
when there is no project file open. 
 

 
 
Once you have a project file open, the below file menu is displayed. You can see that now the 
other menu options are enabled.  Regardless of whether you use the “New”, “Open” or “Recent 
Files” option to open a project file, the “File” Menu will now look like the below. 
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2.4 Close File 
 
When you close a file it will automatically be saved.  Demonstration software packages will not 
save the file that you worked on.   

2.5 “Save As” File 
 
This function allows you to save this file as another file.  This is useful when you have two 
predictions that have similar data inputs.  After this function is complete, the project that you 
create is now in loaded and not the original project.  In the below example, SaveFile will be in 
memory after the “OK” button is pressed assuming that this project name does not already exist. 
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2.6 Global preferences 
 
This dialog allows you to select which unit of measure for time will be displayed in both the 
prediction and estimation results.  Your choices are hours, millions of hours and billions of hours.  
Failure rate will be displayed in terms of whichever of these you select from this dialog.  This 
preference is a global preference in that all files that you create or modify will use this preference.  
You can change this preference anytime that a project file is open.  After the change, all future 
projects will be automatically converted to this unit of measure.  This is a global preference 
because it is usually not changed often within an organization.  If you have the WhenToStop 
estimation module, a message will be displayed indicating that the estimation computations are 
being updated. 
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3.0 Prediction Results 
 
The prediction results show predictions before code is even written.  See the Prediction user’s 
manual for more information on section 3.0. 
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4.0 Estimation Results 
 
The Systems Testing Estimation menu is enabled in the Frestimate Manager’s edition.  These 
functions do estimations based on failure data collected during testing.  To access the Estimation 
Results you must have the Manager’s Edition installed.  Open a file as per section 1 of this 
document and then press the “Test data/growth” button from the main page.  You will then see 
the Estimation results.   
 
See the WhenToStop user’s manual for more information. 
 

 
 
 

Select 
this 
button 
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5.0 Field Metrics Menu 
 
This menu item allows you to input actual MTTF values from customer/ end user sites.   
 

 
 
Internal Fielded MTTF is simply the total number of hours in operation on one average 
system/customer site divided by the total number of unique failures. This is almost always the 
worst case scenario for the fielded MTTF as it is the MTTF if all failures were to be visible to all 
customers.  However, it also presumes that a particular failure is observed only once. 
 
External Fielded MTTF is simply the total number of hours in operation by any customer/delivered 
system divided by the total number of failures regardless of whether they are unique or not.  So, if 
the same defect causes the same failure at 10 systems then 10 failures are counted. The external 
MTTF also takes into consideration the possibility that the same failure may be observed over 
and over at the same customer site. 
 

Select 
this 
button 
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6.0 Tools Menu 
 
The tools menu is new as of version 3.5.  This menu executes the FREstimate Metrics software 
package.   
 

 
 

6.1 Launch FREstimate Metrics 
 
If you have the FREstimateMetrics.exe application installed in the same folder as the FREstimate 
software, this tool menu item will be enabled.  When you select this menu item the following page 
is displayed.  The FREstimate Metrics package has a user's manual and help file for more 
detailed instructions on how to use the metrics component.  Refer to these documents for details. 
Note that only the language modules that you have purchased will be enabled in the below page. 
(The Java language module will be implemented at a future date) 
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6.2 Import FREstimate Metrics 
 
If you have a project file open, you can import the results of the FREstimateMetrics application 
directly into the project file. The below page is displayed when you select this menu item. You 
simply select the results file from the FREstimateMetrics application and then the size and 
complexity are imported into the FREstimate project file.  You will be able to see the imported 
results by going to the “All general inputs page”.   
 

 
 
The size metrics import will convert all language types to assembler and multiply the stand code 
expansion ratios to this for a resulting KSLOC size. The standard code expansion ratios are: 
 
VB and VB .net 6 
C    3 
C++    6 
Ada    6 
 
Since the tool cannot determine what percentage of the code is effective, it will also set the 
EKSLOC and critical EKSLOC to the total size imported from the metrics tool. Please make sure 
that you modified the EKSLOC field so that only the new KSLOC is counted.  Alternatively, you 
can perform the FREstimate metrics on only the effective KSLOC prior to importing the size and 
complexity. The imported complexity is currently used only by the Rome Labs module.    
 

2.7 Modify Report 
 
Frestimate computes many different kinds of results as shown in Figure 1.  For a particular 
project some of these results may be more relevant than others.  This page allows you to select 
which metrics are displayed in the results page. 
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2.8 Print Prediction Project Summary 
 
This will print the results for each prediction model that you have enabled. You can print to the 
screen, to a file or to a printer. Printing is not enabled for the demonstration program.  If you want 
to print the inputs for each of the models you can do so by going to that input screen and printing.  
Graphs can be printed as well as exported and saved to the clipboard. 
 

 



FREstimate Users Manual Copyright SoftRel, 2009 

25 

2.9  Print Estimation Project Summary 
 
This will print the estimation results for the model selected in Systems Testing Estimation-
>Results. You can print to the screen, to a file or to a printer. Printing is not enabled for the 
demonstration program. 
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